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The material contained in this
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the maximum extent permitted by
applicable law, Agilent disclaims all
warranties, either express or implied,
with regard to this manual and any
information contained herein,
including but not limited to the
implied warranties of merchantability
and fitness for a particular purpose.
Agilent shall not be liable for errors
or for incidental or consequential
damages in connection with the
furnishing, use, or performance of
this document or of any information
contained herein. Should Agilent and
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agreement with warranty terms
covering the material in this
document that conflict with these
terms, the warranty terms in the
separate agreement shall control.

Technology Licenses

The hardware and/or software
described in this document are
furnished under a license and may be
used or copied only in accordance
with the terms of such license.

Restricted Rights Legend

If software is for use in the
performance of a U.S. Government
prime contract or subcontract,
Software is delivered and licensed as
“Commercial computer software” as
defined in DFAR 252.227-7014 (June
1995), or as a “commercial item” as
defined in FAR 2.101(a) or as
“Restricted computer software” as
defined in FAR 52.227-19 (June 1987)
or any equivalent agency regulation or

contract clause. Use, duplication or
disclosure of Software is subject to
Agilent Technologies” standard
commercial license terms, and non-
DOD Departments and Agencies of the
U.S. Government will receive no
greater than Restricted Rights as
defined in FAR 52.227-19(c)(1-2) (June
1987). U.S. Government users will
receive no greater than Limited Rights
as defined in FAR 52.227-14 (June
1987) or DFAR 252.227-7015 (b)(2)
(November 1995), as applicable in any
technical data.

Safety Notices

A CAUTION notice denotes a hazard.
It calls attention to an operating
procedure, practice, or the like that, if
not correctly performed or adhered to,
could result in damage to the product
or loss of important data. Do not
proceed beyond a CAUTION notice
until the indicated conditions are fully
understood and met.

A WARNING notice denotes a
hazard. It calls attention to an
operating procedure, practice, or the
like that, if not correctly performed or
adhered to, could result in personal
injury or death. Do not proceed
beyond a WARNING notice until the
indicated conditions are fully
understood and met.

Agilent 240/280 Series AA User's Guide



Contents

Contents

1. Safety Practices and Hazards 7
General 7
Electrical Hazards 8

Heat, Vapors and Fumes 9
Compressed Gases and Cylinders 10

Gas Hoses and Connections 1"
Ultraviolet Radiation 1

Other 12
Warning and Caution Messages 12
Warning Symbols 12

Color Coding 14

CE Compliance 15
Electromagnetic Compatibility 15
EN55011/CISPR11 15

ICES/NMB-001 16

Flame Operation 16
Flammable Solvents 16

Compressed Gases and Cylinders for Flame Operation 18

Acetylene 18
Nitrous Oxide 20
Burners 20
Nebulizer 21
Liquid Trap 22

Agilent 240/280 Series AA User's Guide 3



Contents

Heat Hazards
Perchloric Acid

Flashbacks

Furnace and Zeeman Operation
Gases
Heat Hazards
Vapors and Fumes
UV Radiation
Magnetic Field (Zeeman only)

2. Introduction
Installation Requirements

Agilent AA Documentation

Conventions

Specifications
Environmental
Power
Gas supplies
Weights and Dimensions

3. Installation

PC Requirements

Recommended PC Configuration
Installation Procedure Overview
Guidelines for Software Installation
Installing the SpectrAA Base Software
Installing the SpectrAA PRO Software

22
23

2

26
26
26
27
27
27

29

30

30
30

31
31
32
37
37
39

39
40

I8
1
42
15

4 Agilent 240/280 Series AA User’'s Guide



Contents

Installing the SpectrAA CFR Software 47
Installing the SpectrAA Base Software 47
Installing the SpectrAA CFR Software 50

GPIB Communications 51
Installing the PCI-GPIB Communications Card 51
Configuring the PCI-GPIB Communications Card 54
Installing the USB-GPIB-HS Converter 55

Setting Up for Agilent AA-DUQ Operation 55

Starting the SpectrAA Software 56

SpectrAA Release Notes and Software Status Bulletin 57

Installing the Drivers for the Tube-CAM Furnace Camera Option 57

Driver Installation 58

Printer Setup 60
Troubleshooting 60
4. Software Overview 61
Starting the SpectrAA Software 62
SpectrAA Windows 62
Index Page 62
Worksheet Window 63

Reports Window 65
Administration Window 66
Working With the SpectrAA Software 67
Menu Bar 67

Toolbar 67

Dialog Boxes 67

Agilent 240/280 Series AA User's Guide 5



Contents

Help
Searching for Help
Printing Help
Viewing Help While You Work
Quitting Help

b. Getting Started

Instrument Setup
Connections
Power
Moving Your Instrument

Starting the System

Pre-analysis Checklist

67
68
69
69
69

n

"
72
72
73

73
74

6 Agilent 240/280 Series AA User’'s Guide



General

Safety Practices and Hazards

®
.C ® ¢ « 1. Safety Practices and Hazards

General

Electrical Hazards

Heat, Vapors and Fumes
Compressed Gases and Cylinders
Gas Hoses and Connections
Ultraviolet Radiation

Other

Warning and Caution Messages
Warning Symbols

Color Coding

CE Compliance

Electromagnetic Compatibility
Flame Operation

Flashbacks

Furnace and Zeeman Operation

10
"
11
12
12
12
14
15
15
16
24
26

Your Agilent AA instrument and accessories have been carefully
designed so that when used properly you have an accurate, fast,
flexible and safe analytical system.

If the equipment is used in a manner not specified by the
manufacturer, the protection provided by the equipment may be

impaired.
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Safety Practices and Hazards

Operation of an atomic absorption spectrometer can involve the use
of compressed gases, flames, and hazardous materials including
corrosive fluids and flammable liquids. Unskilled, improper, or
careless use of this instrument can create explosion hazards, fire
hazards, or other hazards which can cause death, serious injury to
personnel, or severe damage to equipment and property.

Information on safety practices is provided with your instrument and
operation manuals, and also referenced in your Agilent accessory
manuals. Before using your instrument or accessories, you must
thoroughly read these safety practices.

Observe all relevant safety practices at all times.

The safety practices described below are provided to help you
operate the instrument safely. Read each safety topic thoroughly
before attempting to operate the instrument and always operate the
spectrometer in accordance with these safety practices.

Electrical Hazards

The instrument and accessories contain electrical circuits, devices
and components operating at dangerous voltages. Contact with these
circuits, devices and components can cause death, serious injury, or
painful electric shock.

Panels and covers that are retained by fasteners which require the
use of a tool for removal may only be opened by Agilent field service
engineers. Consult the manuals or product labels supplied with your
PC, monitor, printer/plotter, water-cooling system and vacuum pump
(where required) to determine which parts are operator-accessible.

Application of the wrong supply voltage, connection of the
instrument to an incorrectly wired supply outlet, or lack of proper
electrical grounding can create a fire hazard or a potentially serious
shock hazard, and could seriously damage the instrument and any
attached ancillary equipment.

Always use a 3-wire outlet with ground connection which is
adequately rated for the load. The installation must comply with local
and national safety regulations.

8 Agilent 240/280 Series AA User’'s Guide



Safety Practices and Hazards

Do not connect the instrument to the mains power supply until you
have made sure that the operating voltage is correctly set for the
mains power supply in the specific outlet in your laboratory to which
the equipment is connected.

Heat, Vapors and Fumes

Heat, vapors and fumes generated by flame, furnace and vapor
generation methods can be hazardous to personnel.

Heat, vapors and fumes must be extracted from the instrument by an
exhaust system. The instrument must be vented into a self-contained
arrangement of collector hood, ducting and exhaust fan. The system
must be vented to the outside air, never within the building. Locate
the system outlet such that the exhaust cannot re-enter the building
through any door, window, air conditioning inlet, or other ventilator.
Construct the system in accordance with local codes and regulations
for ventilation.

The exhaust system must be capable of providing an exhaust
ventilation rate of at least 6 cubic meters per minute (200 cfm).
Locate the exhaust fan at least 3 meters (10 feet) away from the
flame and as close to the outlet as possible. The motor must be
mounted away from the hot gases, and plastic parts must not be used
as they will melt. Fit a back-draft damper to the outlet end of the
system. Equip the exhaust fan power supply with an indicator close
to the instrument to indicate whether the exhaust fan is on or off.
Always switch the exhaust fan on before lighting the flame.

Use fireproof ducting that is in accordance with your local fire
prevention regulations. Locate the ducting away from fire alarms,
sprinkler heads and other heat-sensitive devices. Do not make solder
joints in the ducting—the hot exhaust in the duct may melt the joint.

Regularly check the system by smoke test to ensure that the exhaust
system is working.

When operating the atomic absorption spectrometer, always have the
chimney in place to ensure correct ventilation.
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Safety Practices and Hazards
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Compressed Gases and Cylinders

All compressed gases (other than air) can create a hazard if they leak
into the atmosphere. Even small leaks in gas supply systems can be
dangerous. Any leak (except that of air) can an explosion hazard, a
fire hazard, or result in an oxygen-deficient atmosphere. Such
hazards can cause death, serious injury, asphyxiation, anesthetic
effects, and serious damage to equipment and property.

Cylinders must be stored and handled strictly in accordance with
local safety codes and regulations. Cylinders must be used and stored
only in a vertical position. Secure all cylinders to an immovable
structure or a properly constructed cylinder stand. The area in which
cylinders are stored must be adequately ventilated to prevent toxic or
explosive accumulations. Move cylinders only on a properly
constructed trolley.

Keep cylinders cool. This rule applies to every cylinder of
compressed gas. Cylinders have pressure relief devices that release
the contents of the cylinder if the temperature exceeds 52 °C

(125 °F).

Ensure that all cylinders are clearly labeled so that there can be no
doubt about the contents. If the cylinder label is not legible, do not
use the cylinder—return it to your supplier. Always ensure that you
have the right cylinder before connecting the cylinder to the
instrument.

If air is supplied from a compressor, all moisture must be extracted
from the air before it is supplied to the gas control module. Moisture
can affect the internal components of the gas control system and
create a potentially hazardous situation.

Use only approved regulators and hose connectors.
Never attempt to refill cylinders.

Remember that for cylinder connections, left-hand thread fittings are
used for fuel; right-hand thread fittings are used for support gases.

When your analytical program is complete, or at the end of the
working day, always ensure that all gas supplies are turned off at the
cylinders.

Agilent 240/280 Series AA User’'s Guide



Safety Practices and Hazards

Gas Hoses and Connections

Even small leaks in gas supply systems can be dangerous. Any leak
can create an explosion hazard, a fire hazard, or can result in an
oxygen-deficient atmosphere. Such hazards can cause death, serious
injury, asphyxiation, anesthetic effects, and serious damage to
equipment and property.

Use only approved regulators, connectors and fittings. If in any
doubt, consult your local gas supplier or your Agilent representative.

Ensure that all gas connectors and hoses are correctly assembled.

Arrange gas hoses so that they will not be damaged, stepped on, or
have things dropped on them.

Never use frayed or damaged hoses.

Perform leak tests at all joints and seals every day before the
instrument is used. Test for leaks with a brush and soapy water or a
proprietary leak-detecting solution. Never use a naked flame when
testing for leaks.

Ultraviolet Radiation

Hazardous ultraviolet radiation is emitted by flames, hollow cathode
lamps and deuterium lamps. This radiation can cause serious damage
to human eyes and skin.

Always wear safety glasses conforming to an approved standard, and
certified or otherwise warranted to protect the eyes from ultraviolet
radiation. Never look directly at the light emitted by a hollow cathode
lamp.

When using a flame, always operate your spectrometer with the
flame shield closed, and the sample compartment front panel and
chimney in place.
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Safety Practices and Hazards

Other

Other specific warnings and cautions appear in the manual and in
the online Help where appropriate, and detail the specific hazard,
describe how to avoid it, and specify the possible consequences of
not heeding the warning or caution.

Warning and Caution Messages

Name of Warning
A 'Warning’ message is used in the text when failure to observe instructions
or precautions could result in death or injury.

A ‘Caution’ message is used when failure to observe instructions could result in
damage to equipment (Agilent supplied and/or other associated equipment).

A ‘Note’ message is used to give advice or information.

Warning Symbols

12

The following is a list of symbols that appear in conjunction with
warnings in this manual and on the spectrometer. The hazard they
describe is also shown. The beginning of the warning text is noted by
a warning icon:
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Safety Practices and Hazards

A triangular symbol indicates a warning. The meanings of the
symbols that may appear alongside warnings in the documentation
or on the instrument itself are as follows:

>

i
[ =
Corrosive liquids Electrical shock Explosion hazard
Eye hazard Fire hazard Heavy weight

(danger to feet)

>
>

Heavy weight Hot surface Magnetic field

(danger to hands)

Moving part Noxious gases Sharp object

2
SN

Toxic material

>
D

Read all warnings and cautions carefully and observe them at all
times.

The following symbol may be used on warning labels attached to the
instrument. When you see this symbol, refer to the relevant operation
or service manual for the correct procedure referred to by that
warning label.
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Safety Practices and Hazards

The following symbols appear on the instrument for your
information.

Color Coding

I Mains power on

Mains power off

Fuse
Single phase alternating current
When attached to the rear of the instrument, it indicates that the

product complies with the requirements of one or more EU
directives.

Flame off

Flame on

FRASTP

Indicates lamp present

1
. ’
::s
'

When attached to the rear of the product, indicates that the
product has been certified (evaluated) to CSA 61010.1 and UL
61010-1.

© L/
&)
®

c
7]

The various indicator lights appearing on Agilent instruments and
associated accessories are color coded to represent the status of the
instrument or accessory.

14

A green light indicates the instrument is in normal/standby
mode.

An orange light indicates that a potential hazard is present.
A blue light indicates that operator intervention is required.

A red light warns of danger or an emergency.
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Safety Practices and Hazards

CE Compliance

Your Agilent AA instrument has been designed to comply with the
requirements of the Electromagnetic Compatibility (EMC) Directive
and the Low Voltage (electrical safety) Directive (commonly referred
to as the LVD) of the European Union. Agilent has confirmed that
each product complies with the relevant Directives by testing a
prototype against the prescribed EN (European Norm) standards.

Proof that a product complies with these directives is indicated by:
e the CE Marking appearing on the rear of the product, and

¢ the documentation package that accompanies the product
containing a copy of the Declaration of Conformity. The
Declaration of Conformity is the legal declaration by Agilent that
the product complies with the directives listed above, and shows
the EN standards to which the product was tested to
demonstrate compliance.

Electromagnetic Compatibility

EN55011/CISPR11

Group 1 ISM equipment: group 1 contains all ISM equipment in
which there is intentionally generated and/or used conductively
coupled radio- frequency energy which is necessary for the internal
functioning of the equipment itself.

Class A equipment is equipment suitable for use in all
establishments other than domestic and those directly connected to a
low voltage power supply network which supplies buildings used for
domestic purposes.

This device complies with the requirements of CISPR11, Group 1,
Class A as radiation professional equipment. Therefore, there may be
potential difficulties in ensuring electromagnetic compatibility in
other environments, due to conducted as well as radiated
disturbances.

Operation is subject to the following two conditions:

1 This device may not cause harmful interference.
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2 This device must accept any interference received, including
interference that may cause undesired operation.

If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try one or more
of the following measures:

1 Relocate the radio or antenna.
2 Move the device away from the radio or television.

3 Plug the device into a different electrical outlet, so that the device
and the radio or television are on separate electrical circuits.

Make sure that all peripheral devices are also certified.

Make sure that appropriate cables are used to connect the device
to peripheral equipment.

6 Consult your equipment dealer, Agilent Technologies, or an
experienced technician for assistance.

7 Changes or modifications not expressly approved by Agilent
Technologies could void the user’s authority to operate the
equipment.

ICES/NMB-001

This ISM device complies with Canadian ICES- 001.

Cet appareil ISM est conforme & la norme NMB-001 du Canada.

Flame Operation

Flammable Solvents

Unskilled, improper, or careless use of flammable solvents in or near
an atomic absorption spectrometer can create explosion hazards and
fire hazards. These can result in death, or severe personal injury or
burns.

Remember at all times that the combination of a flame and flammable
solvents can present a serious hazard. All relevant safety practices
governing the use of flammable solvents must be strictly followed.

Agilent 240/280 Series AA User’'s Guide



Safety Practices and Hazards

To reduce the possibility of fire or explosion:

When initially selecting an organic solvent, choose a solvent
having the highest flash point consistent with your analytical
requirements.

Never use a solvent having a specific gravity lower than 0.75.

Never leave uncovered containers of flammable solvent standing
near the burner. When aspirating such solvents, always use a
covered container and feed the capillary tubing through a 2 mm
diameter hole in the cover. Always use the smallest volume of
solvent consistent with your analytical requirements.

Always use solvent-resistant tubing such as nitrile rubber for the
drainage system and the vapor vent. Lead the drainage tube to a
suitable wide-necked waste vessel (as described in the next
paragraph). The standard plastic laboratory tubing supplied with
your instrument is not suitable for draining organic solvents or
venting organic vapors. If organic or toxic solutions are being
used in the spray chamber, vent tubing must be connected to the
vapor vent on the liquid trap, run parallel to the drain tubing,
and led to an active exhaust system. Do not lead the vapor tubing
to the waste vessel. If you are not using toxic or hazardous
liquids in the spray chamber, leave the vapor vent uncovered.

Use small, wide-necked waste vessels and empty them
frequently—do not accumulate large volumes of flammable
solvent. Do not use glass waste vessels—use vessels made of a
material that will not shatter in the event of a flashback. Metal
vessels will corrode and it is difficult to determine the level of
liquid in them. Ensure that your waste vessel is below the
instrument and located in an open, well-ventilated position
where you can see it. Never locate the vessel in a confined space.

When your analytical program has been completed, or at the end
of the working day, always empty and rinse the waste vessel.

When your analytical program has been completed, or at the end
of the working day, always empty, clean and refill the liquid trap.

Do not mix nitric or perchloric acid residues with organic solvent
residues.

Agilent 240/280 Series AA User's Guide 17



Safety Practices and Hazards
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Keep the burner slot, spray chamber and liquid trap clean.

Always use the internal igniter to light the flame as the flame will
not operate unless all the safety interlocks are satisfied.

exhaust

Tﬁ system
operating

. e

bench I S

small non-glass

wasts vessel in full
view of operator

Figure 1. System setup diagram

vapor vent
| p

drain tubing must
slope downwards
faor full length, with
no kinks

wide opening
keep end of tube

above highest
liguid level

X

large stable base

Compressed Gases and Cylinders for Flame Operation

This spectrometer is to be used only with air, nitrous oxide, and

acetylene for flame operation.

Never use oxygen or oxygen-enriched air as the oxidant because this

will result in an explosion.

Never use any gas except acetylene as the fuel gas.

Acetylene

Unskilled, improper, or careless use of acetylene can create explosion
hazards and fire hazards which can result in death, severe personal
injury or burns.
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Safety Practices and Hazards

Use acetylene at pressures lower than 105 kPa (15 psig). At pressures
above this level, acetylene can explode spontaneously. Your Agilent
AA is designed to operate at fuel supply pressures between 65 and
100 kPa (9.5-14.5 psig). Refer to the Specifications section or the rear
of the instrument for the exact range and recommended pressure.

Do not use any tubing or connector that reacts chemically with
acetylene. Never pass acetylene through copper tubing, or brass
tubing or fittings containing more than 65% copper, since this may
provoke an explosion. Never bring acetylene into direct contact with
copper, silver, liquid mercury, gaseous chlorine or grease, as an
explosion could result.

Use only acetylene that is packed in acetone. Some gas suppliers
offer acetylene packed in material other than acetone. While these
alternatives may overcome some of the disadvantages of acetone,
they may also introduce the more serious problem of corrosion in the
gas control module and must not be used with Agilent atomic
absorption spectrometers.

If the pressure in the acetylene cylinder is allowed to fall below

700 kPa (100 psig), or the consumption is greater than 1/7 of the
cylinder contents per hour, acetone may be carried over from the
cylinder and into the spectrometer. Acetone in the spectrometer can
damage seals, O-rings and hoses, degrade analytical performance and
precipitate flashbacks.

Minimize the amount of acetone which is carried over with the
acetylene by:

¢ Replacing cylinders when their contents pressure drops below
700 kPa (100 psi)

¢ Ensuring that the rate of acetylene drawn off from each cylinder
is not excessive.

If high rates of consumption are observed then connect 2 or more
cylinders in parallel to a manifold. This reduces the rate at which
acetylene is drawn from each cylinder.
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To reduce the possibility of fire or explosion:

e Test the supply ‘plumbing’ regularly for leaks with a brush and
soapy water or a proprietary leak-detecting solution (never use a
naked flame when testing for leaks)

e ‘Crack’ the cylinder before use by gently opening the valve to
check for any drops or spray of acetone. Any cylinder showing
acetone should be returned to the supplier for replacement.

Use ‘Instrument Grade’ acetylene that is at least 99.5% pure.

Turn off fuel gas at the cylinder when you have finished your flame
analysis.

Refer also to your local regulations governing the use of acetylene.

Nitrous Oxide

The de-compression of high pressure N,O gas at the regulator can
cause excessive cooling and eventual freezing of the regulator. To
prevent regulator malfunction and possible flashback, the gas should
be heated with an in-line or wrap-around heater.

Burners

Improper or careless use of burners can create explosion hazards
and fire hazards which can cause death, serious injury to personnel
and damage to equipment and property.

Whenever you handle burners, remember that the burner may be
very hot. Always use protective gloves to handle burners.

Burners are clearly identified by the fuel/oxidant combination for
which they are intended. Always fit the correct burner. Never
attempt to use an air-acetylene burner for nitrous oxide-acetylene, as
this will cause a flashback.

Use only acetylene as the fuel gas.

Use only air or nitrous oxide as oxidant. Never attempt to use oxygen
or oxygen-enriched air, as this will cause a flashback.
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Burner interlocks are incorporated to minimize the possibility of
using the wrong burner. Never interfere with or attempt to bypass
any interlock fitted to this instrument.

To minimize the rate of burner blockage, the burner slot must be
cleaned and polished as described in the Maintenance section.

Never allow burners to become blocked. Progressive burner blockage
can increase the static pressure in the liquid trap to the point at
which the liquid seal is breached. This can cause a flashback and
create an explosion hazard or a fire hazard.

Never allow carbon to build up on the slot, as glowing particles can
dislodge and fall through the slot, causing a flashback.

Always turn the flame off before attempting to clean the burner slot.
Never clean the slot of a burner while a flame is running.

Never leave a flame unattended.

Never disassemble or modify a burner. Never use a damaged burner.

Nebulizer

Incorrect assembly and fitting of nebulizers to an atomic absorption
spectrometer can create explosion hazards and fire hazards which
can cause serious injury to personnel and damage to equipment and
property.

Ensure that the nebulizer is correctly assembled and correctly fitted
to the spray chamber before lighting the flame. Nebulizers should be
correctly adjusted before lighting the flame.

Never remove a nebulizer from the spray chamber while the flame is
on, and do not use a mechanical device (for example, a wire) to clean
the capillary of a nebulizer while a flame is operating. Always
extinguish the flame before removing the nebulizer from the spray
chamber.

Regularly test all connections for leaks. Rectify all leaks before
lighting the flame.
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Liquid Trap

Improper use of the liquid trap can create explosion hazards, fire
hazards, and toxic vapor hazards which can result in death or serious
personal injury.

The liquid trap interlock is incorporated to minimize the possibility
of attempting to operate the instrument with an empty trap or with
the drain tube missing. Never interfere with this interlock. Never
attempt to bypass this interlock.

Always fill the liquid trap with the same solvent that is being used for
your samples.

The trap is designed to provide a liquid seal under all normal
conditions with solutions having a specific gravity greater than 0.75.
Never use a solution or solvent having a specific gravity lower than
0.75, otherwise the liquid seal can be breached. This can create a
flashback and create an explosion hazard or a fire hazard.

A length of tubing must be connected to the drain outlet on the trap
and led to a suitable waste vessel. The free end of the tubing must
remain above the liquid in the waste vessel. Do not use glass waste
vessels—use vessels made of a material that will not shatter in the
event of a flashback.

A length of tubing should be connected to the vapor vent (the upper
nipple) on the liquid trap when you are analyzing organic or toxic
liquids. This tubing should be led out from the sample compartment,
parallel to the drain tubing, and must slope downwards to enable any
liquid overflow to drain out and prevent the tubing from becoming
blocked. Do not lead the vapor tubing to the waste vessel. If
necessary, an active exhaust system should be used to draw away
toxic vapors. If you are not analyzing solutions of a toxic nature,
leave the vapor outlet uncovered.

Heat Hazards

An open flame, burners and other hot surfaces can present heat
hazards that can result in severe burns.

Agilent 240/280 Series AA User’'s Guide



Safety Practices and Hazards

When operating a flame system, always operate your spectrometer
with the flame shield closed, and the sample compartment front
panel in place. Keep your hands out of the sample compartment
while a flame is burning.

When operating a flame system make sure the chimney is in place
with the cutaway skirt (if present) to the back. Before you touch the
instrument chimney, turn the flame off and allow the chimney to
cool.

When you change burners, remember that the burner may be very
hot. Always use protective gloves when removing a burner from the
instrument.

Perchloric Acid

Aspiration of perchloric acid and perchlorates into a nitrous oxide-
acetylene flame can create an explosion hazard which can result in
death or serious injury, including temporary or permanent
impairment of hearing.

Do not use perchloric acid unless it is absolutely essential for sample
preparation. If perchloric acid must be used, it may be possible to
reduce the risk of explosion by taking the following measures:

¢ Use an air-acetylene flame instead of a nitrous oxide-acetylene
flame.

¢ Reduce the concentration of perchloric acid and metal in all
analytical solutions to the lowest practicable level. The
concentration of perchloric acid should be reduced in the
digestion stage and further reduced by extending the fuming
stage.

e Aspirate all solutions for the shortest practicable period.

e Aspirate distilled water between samples. Minimize the
aspiration of air.

e Use separate spray chamber/liquid trap and drain assemblies for
perchloric acid analyses and organic solvent analyses to prevent
perchloric acid from mixing with organic solvent residues.
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When solvent extractions of perchloric solutions are performed, some of the acid
may dissolve in the organic solvent that is subsequently aspirated. Also, if the
organic solution is aspirated while floating on the surface of the acid, do not
allow the capillary tube to drop below the organic layer and suck up agqueous
perchloric acid.

24

When using perchloric acid, wear approved ear protectors and
approved safety glasses and ensure that all instrument safety covers
are in position.

Flashbacks

Analysis over many years has shown that in most cases, flashbacks
are associated with one or more of the following points. If you
experience a flashback, check this list to see if any of the points are
relevant, and take steps to remedy the situation.

1 Keep the burner clean. Deposits must not be allowed to build up
in or on the burner slot because they can partially block it (thus
causing the pressure to build up in the spray chamber and breach
the seal provided by the liquid trap), or glowing particles can fall
down through the slot into the spray chamber and ignite the
combustible gas mixture inside.

The use of a hard object to brush off glowing carbon particles
during flame operation is not recommended because of the
increased risk of knocking one of the particles down the slot.
When using an organic solvent, a reduced uptake rate should be
used to restrict the amount of liquid fuel that is fed to the flame.

2 The width of the burner slot must not exceed the maximum
design specification [Mark VIA: 0.47 mm (0.0185 in.) for N,0;
Mark 7 0.46 mm (0.0181 in.) for N,O; or 0.54 mm (0.021 in.) for
air]. Even a small increase in width can greatly increase the
possibility of a flashback occurring.

The burner slot must be regularly cleaned according to the
instructions included in the Maintenance chapter of this manual.
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3 Ensure that the spray chamber and liquid trap are kept clean.
If dirty solutions are being analyzed (for example, engine oils),
ensure that the spray chamber, liquid trap, float and drain tube
are regularly cleaned and flushed with a suitable solvent so that
sludge does not build up in the parts.

4 Ensure that the correct O-rings are used on the burner, nebulizer
block and nebulizer, and that they remain undamaged.
Damage to O-rings in the spray chamber can result in the leakage
of gas which can be ignited by the flame and in turn set fire to the
spray chamber.
Damage to O-rings in the nebulizer can allow leakage of the
oxidant which can reduce the total flow of gas through the
burner slot and so increase the possibility of a flashback
occurring.

5 The liquid trap must be filled with the same solution as the
matrix used for the standards and samples.

6 The drain tube must be attached to the lower nipple of the liquid
trap, and it must slope downwards all the way to the drain vessel
so that the waste liquid drains smoothly.

The end of the drain tube must not be allowed to drop below the
level of the liquid in the vessel. (Conversely, the level of liquid
must not be allowed to rise sufficiently to cover the end of the
tube.)

When using organic or toxic liquids in the spray chamber, a vent
tube must be attached to the upper vent nipple of the liquid trap.
It must slope downwards (running parallel to the drain tube) to
prevent it becoming blocked should any liquid drain out, and be
vented to an active exhaust system.

All of the above points must be observed because a sudden surge
of waste liquid can affect the pressure in the spray chamber and
result in a flashback.

7 Since N,0 is stored in the cylinder under pressure as a liquid,
when it expands through the regulator it can cool the regulator
sufficiently to form ice on the outside and prevent it from
operating correctly.

Prevent freezing by using a heater on the N,O regulator on the
supply cylinder. Contact the supplier of the regulator for a
suitable heater.
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8 As free acetylene is unstable at elevated pressure, it has to be
stored in the cylinder by dissolving it in acetone.
If the gas is withdrawn too quickly, or the cylinder pressure is
allowed to drop below 700 kPa, acetone may be drawn off in
sufficient quantities to affect analytical performance, damage
seals, O-rings and hoses, or even cause a flashback. Observe the
recommendations concerning the use of acetylene.

9 Where possible, you should not perform digests with perchloric
acid. As this acid is well known for forming unstable salts,
operators using this acid should ensure that the minimum
amount is allowed to reach the spectrometer, and that the
burner, spray chamber and liquid trap are thoroughly cleaned
after each analysis to ensure that unstable salts are not allowed
to build up. Failure to do this can result in unpredictable
flashbacks.

10 Aspirating solutions (especially alkaline/ammoniacal ones) that
contain high concentrations of Ag and Cu can lead to the
formation of acetylides which can spontaneously decompose and
cause a flashback.

Furnace and Zeeman Operation

Gases

The graphite tube atomizer gas supply system is designed for use
with inert gases and air.

Never use pure hydrogen with the graphite tube atomizer since this
could result in leakage and potentially explosive accumulation of
hydrogen. You may, however, use a proprietary, prepackaged mixture
of 95% argon (or nitrogen) and 5% hydrogen. Never attempt to create
your own mixture of hydrogen and an inert gas for use with the GTA
system.

Heat Hazards

A hot furnace atomizer can present heat hazards that can result in
severe burns to personnel. Never put your hands in the sample
compartment while you are operating your furnace.
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Allow the furnace atomizer to cool before removing it from the
sample compartment.

Vapors and Fumes

Never place your head over the graphite tube atomizer while it is
operating. This could cause inhalation of hazardous or toxic fumes,
or your skin and eyes could be injured by corrosive vapors or fumes.

The chimney or the optional exhaust accessory must be in place for
furnace operation to ensure that toxic vapors and heat are
exhausted.

UV Radiation

When viewing the sample during the drying stage, use only a rear
coated mirror (as supplied) or the Tube-CAM option. Never look
directly at the furnace during either the ash or atomize stages.

Magnetic Field (Zeeman only)

The magnet produces a variable magnetic field of up to 0.8 Tesla peak
at mains frequency in the workhead during the read stage.

To avoid interference with heart pacemakers or magnetic storage
media, keep them at least 300 mm from the magnet.
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The Agilent 200 series AA spectrometers are controlled by Agilent’s
innovative AA worksheet software. The Agilent series AA includes
the following instruments:

240/240FS AA, 2407 AA, 280 AA and 280Z AA.

This documentation is appropriate for all of the instruments listed
above.

The software is based on a spreadsheet that mimics an analyst’s
workbook and combines flame, furnace, Zeeman and vapor operation
in one integrated package.

The SpectrAA Base and PRO software versions run under Microsoft®
Windows® 7 64-bit (the SpectrAA CFR Software is only supported
using Microsoft XP® (Service pack 3)) operating systems, and
provides the following:

¢ Innovative, easy to use interface
¢ Dedicated function keys for critical functions

e Extensive Help including audio and video demonstrations of how
to set up your instrument
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e “Tool Tips” state the allowed range for each field
¢ Comprehensive error system

e The capacity to simultaneously operate one flame and one
furnace (deuterium or Zeeman) spectrometer simultaneously
from one computer (requires SpectrAA PRO version software)

¢ Features to assist users to achieve compliance with US FDA 21
CFR Part 11 requirements (optional CFR version only) which
currently only runs under Windows XP (Service pack 3)

Installation Requirements

Before you receive your instrument, you are given an Agilent AA Site
Preparation Guide; which describes the environmental and operating
requirements of the Agilent AA system. You must prepare your
laboratory according to those instructions before the Agilent AA can
be installed. You should keep the Site Preparation Guide for future
reference. If you have misplaced your copy, you can obtain a
replacement from your local Agilent office.

Agilent AA Documentation

30

This manual covers the installation of the Agilent SpectrAA software
for 240/280 series AA instruments. Instructions for installing,
operating and maintaining the instruments are included in the
SpectrAA Help (see Page 67).

Operating instructions for the Sample Introduction Pump System
(SIPS) and other AA accessories are given in the manuals
accompanying the accessories or in the SpectrAA Help

Conventions

The following conventions have been used throughout this manual:

e Single quotes (‘ ) indicate a selection you can make from several
choices, such as radio buttons, checkboxes and software items.

e ALL CAPITALS indicates text you must type in from the
keyboard (e.g. type SETUP at the prompt).
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Specifications

Your Agilent AA instrument is designed for indoor use. It is suitable
for the following categories:

e Installation category II
¢ Pollution degree 2

e Equipment Class I

Environmental
Condition Altitude Temp Humidity (%RH)
t(°C) non-condensing
Non-operating (transport) 0-2133 m 5-45 20-80
(0-7000')
Operating within 0-853 m 10-35 8-80
performance specifications (0-2800")
853-2133 m 10-25 8-80
(2800-7000')

For optimum analytical performance it is recommended that the
ambient temperature of the laboratory be between 20-25 °C and be
held constant to within +2 °C throughout the entire working day.

Agilent 240/280 Series AA User's Guide 31



Introduction

Power
System unit Required supply voltage Rating
240 AA 100 VAC +10% -5% 170 VA

120, 220 or 240 VAC £10%
230 VAC +14% -6%

230 VAC +6% -14%

50 or 60 Hz +1 Hz

280 AA 100 VAC +10% -5% 230 VA

120, 220 or 240 VAC £10%
230 VAC +14% -6%

230 VAC +6% -14%

50 or 60 Hz £1 Hz

Zeeman version

240Z AA 208-240 VAC £ 10 % 3500 VA **
50 or 60 Hz + 1 Hz

280Z AA 208-240 VAC £ 10 % 3500 VA **
50 or60 Hz £ 1 Hz

GTA accessory power supply 208, 220 or 240 VAC + 10% 3500 VA **

230 VAC + 14% - 6%
230 VAC + 6% - 14%
50 or 60 Hz + 1 Hz

** In normal operation, the Zeeman and GTA units draw surge
currents in excess of the nominal rating. Power supplies to these
units must be isolated from other supplies to the system and should
include delayed action protection devices such as circuit breakers or
motor start fuses.

Surges in the Zeeman instrument occur in the “read” cycle during
atomization and may be up to 28 A for up to 10 seconds in any
1 to 2 minute period.

Surges in the GTA accessory depend on the choice of ramp rate and
programmed temperature and may be up to 35 A for approximately
1 second, reducing to about 20 A for up to 10 seconds, perhaps
repeating every 1 to 2 minutes.
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Agilent AA instruments are supplied with different power plugs to

suit the area into which they are sold:

AA instrument

Introduction

GTA 120, Zeeman

Area - code Plug supplied
Australia -00 10 A, 250 VAC Clipsal 439D15M
Complies with AS3112
USA -01 Complies with NEMA 5-15P Complies with NEMA L6-30P
(Hubbell #2621)
Canada -01 Complies with NEMA 5-15P 20 A, 250 VAC, Complies with
NEMA L6-20P
(Hubbell #2321+)
Europe -02 Perena 3410 (Complies with CEE 7 Kaiser CEBEC 616 VDE
Sheet VIl or NFC 61.303) (Complies with DIN 49441R2)
Suitable socket required
Australia -00 General purpose 10 A 250 V outlet Dedicated circuit, 15 A 250 V
(HPM 787, Clipsal 15) outlet
(HPM 787/15, Clipsal 15/15)
USA -01 To comply with NEMA 5-15R (15 A To comply with NEMA L6-30R
supply) (Hubbell 1G 5262) (30 A supply)
(Hubbell #2626)
Canada -01 To comply with NEMA 5-15R (15 A 20 A, 250 VAC, Complies with
supply) (Hubbell 1G 5262) NEMA L6-20R
(Hubbell #2326+)
Europe -02 To comply with CEE 7 standard No.7 No standard known (Kaiser CEBEC

Power supply, current rating
and overload protection

Power supply

Sheet VII, or Norma Francais €61.303
Sheet V.A.

Between 5 and 20 A

Single phase

Agilent 240/280 Series AA User's Guide
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Between 30 and 40 A

Single phase
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Other Electrical Connections

Rear of instrument:

IEEE 488

Accessory, 9-way female D-range type

Accessory, MCA, 6 way DIN type (AA280FS and AA280Z only)
USB port, optional

UltrAA lamp connections: Burndy circular 6-way, optional
(actual number depends on the model and option selected)

Shock Hazard
High voltage— To maintain safety, only the UltrAA lamp power supplies
should be used at these connections.

Front of instrument:

Zeeman workhead CPC 14 way connection behind the Left cover
(Zeeman only).

Shock Hazard

To prevent connector damage, switch OFF the instrument before inserting the
plug and always turn the locknut fully clockwise to the detent position. To
maintain safety, only the Zeeman workhead connector should be used at this
connection.
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Lamp bay:

e Deuterium lamp:
Molex 3-way connection, in lamp compartment (behind lamp
panel in lamp compartment on 240/280 series AA instruments).

m Shock Hazard

To maintain safety, only the deuterium lamp should be used at these
connections.

¢ Hollow cathode lamps:
4 lamp capacity on the 240 series AA
8 lamp capacity on the 280 series AA

m Shock Hazard

High voltage — To maintain safety, only hollow cathode lamps should be used
at these connections.

Agilent 240/280 Series AA User's Guide 35



Introduction

Fuses

Non-Zeeman

240 series AA

T2.5 A H250 V, IEC 127 sheet 5, 5x 20 mm (100-120 & 220-240 VAC)
280FS AA

T4 A H250 V, IEC 127 sheet 5, 5x 20 mm (100-120 & 220-240 VAC)
Zeeman

240Z/280Z AA

15 A long delayed-action circuit breaker with a thermal cutout.
T3.15 A H 250 V, IEC 127 sheet 5, 5 x 20 mm (208-240 VAC)
T3.15 mA L 250 V, IEC 127 sheet 2, 5 x 20 mm (208-240 VAC)
T1 AL 250V, IEC 127 sheet 2, 5 x 20 mm (208-240 VAC)
T8 A L 250 V, IEC 127 sheet 2, 5 x 20 mm (208-240 VAC)
T800 mA L 250 V, IEC 127 sheet 2, 5 x 20 mm (208-240 VAC)

For safety reasons, any other internal fuse or circuit breaker is not operator
accessible, and should be replaced only by Agilent field service engineers.

36

Fuse information on the rear of the instrument is the most up to
date.
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Gas supplies

CzH: Air N20 Air Purge
Instrument grade Must be clean & Instrument grade
>99.5% pure dry. (Air filter to be  >99.5% pure
used if required)
Allowed range 65-100 kPa 245-455 kPa 245-455 kPa 245-455 kPa
(9.5-14.5 psi) (35-65 psi) (35-65 psi) (35-65 psi)
Recommended 75 kPa (11 psi) 350 kPa (50 psi) 350 kPa (50 psi)
Typical flow rate  0-10 (L/min) 13.5-20 (L/min) 11-16 (L/min) 10 (L/min)
Connection 1.8 m (6 ft) length 1.8 m (6 ft) length 1.8 m (6 ft) length Barb to take
of 6.3 mm (1/4 in) of 6.3 mm (1/4 in) of 6.3 mm (1/4 in) 6.3 mm (1/4 in)
ID red hose with ID black hose with 1D blue hose with hose
9/16 in-18UNF L/H  9/16 in-18UNF % in-16UNF
thread fitting# fitting# fitting#

#Adaptors are available

Other gas connections

Sample compartment: Push-on Air/N,O connector for burner
Push-on C,H, connector for burner

Weights and Dimensions

Spectrometer System unit Width Depth Height Weight

240 AA instrument only 790 mm (31in.) 585 mm (23in.) 575 mm (22.5in.) 56 kg (123 Ib)
240 AA instrument and 1215 mm (48 in.) 780 mm (31in.) 880 mm (35in.) 97 kg (213 Ib)
shipping box

280 AA instrument only 790 mm (31in.) 585 mm(23in.) 735 mm (29 in.) 69 kg (152 Ib)
280 AA instrument and 1170 mm (46 in.) 890 mm (35in.) 890 mm (35in.) 106 kg (234 Ib)
shipping box

280Z AA instrument only 790 mm (31in.) 585 mm (23in.) 735 mm (29 in.) 61 kg (135 Ib)
280Z AA instrument and 1170 mm (46 in.) 890 mm (35in.) 890 mm (35in.) 92 kg (203 Ib)
shipping box
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This chapter describes how to prepare your personal computer (PC)

and printer for use with the Agilent AA system and install the
SpectrAA software on your PC.

PC Requirements

If you are supplying your own PC for use with an Agilent AA

instrument, the recommended configurations of that PC are listed on

the following page.

Agilent 240/280 Series AA User's Guide
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Recommended PC Configuration

IBM compatible PC with 2.66 GHz processor

4 GB RAM

500GB Hard disk drive

256MB Graphics card supporting 1024 x 768 resolution
16 speed DVD drive

Integrated audio/sound card and speakers

Keyboard and Mouse

19 in LCD Monitor

Windows 7 Professional 64-bit (Service Pack 1) operating system*

The PC must have one spare PCl expansion slot for the Agilent PCI-GPIB
interface card.

If SPS 3 or ETC 60 accessories are being used an RS232 port is
required for each of these.

A USB port is required if the camera option is to be used.

* Windows XP (SP3), with NTFS file system is required for the SpectrAA CFR
version. Currently, SpectrAA CFR is not compatible with Windows 7.

40
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Installation Procedure Overview
There are three software installation scenarios:

¢ SpectrAA Base (for use with SpectrAA Base version 5.2 or
greater and Windows 7 Professional 64-bit SP1 operating
systems)

e SpectrAA PRO (for use with SpectrAA PRO version 5.2 or greater
and Windows 7 Professional 64-bit SP1 operating systems)

e SpectrAA CFR (for use with SpectrAA CFR software version 5.1
and Windows XP SP3 operating systems only)

The following table lists the procedure for each software installation

scenario.
SpectrAA Base (Page 42) SpectrAA PRO (Page 45) SpectrAA CFR (Page 47)
1. Install SpectrAA Base 1. Install SpectrAA Base 1 Install SpectrAA Base v 5.1(27)
2. Configure instrument for 2. Configure one or two 2 Configure one or two
use instruments for use instruments for use
3. Install SpectrAA Help and 3. Install SpectrAA Help and 3 Install SpectrAA Help and
Videos Videos Videos
4. Install GPIB 4. Install SpectrAA PRO 4 Install SpectrAA CFR
Communications Card or 5. Install GPIB Communications 5 Install GPIB Communications
USB-GPIB-HS Converter Card or USB-GPIB-HS Converter Card
6. Configure for DUO operation (if 6 Configure for DUO operation (if
DUO is used) DUQ is used)

Guidelines for Software Installation

The following information assumes that you are working on a clean,
empty hard disk. If you have any other files on the PC hard disk,
ensure that you make backups of these files before continuing.

Agilent will not assume responsibility for the loss of data files or third party
software.

For instructions on installing the Windows operating system refer to
the documentation supplied with Microsoft Windows. It is the
responsibility of the customer to ensure that the Microsoft Windows
operating system is installed on the computer.
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Installing the SpectrAA Base Software

This procedure is for SpectrAA version 5.2 or greater and Microsoft Windows 7
Professional 64-bit SP1 operating systems only.

42

10

Close down all Microsoft Windows applications.

Insert the SpectrAA Base CD-ROM into your CD-ROM drive. The
installation program should start automatically. If the program
does not auto start, do the following:

a From the Windows Start menu, select All Programs >
Accessories > Run. The Run dialog displays.

b In the Run dialog, type X:\SpectrAABase.exe (where X
represents the letter of your CD-ROM drive) and select OK to
start the installation.

¢ Click Yes on the User Account Control window to run the
program.

Select the language from the drop-down menu to use during the
installation of the SpectrAA software. Click OK.

Select Next to start the installation.

Review the License Agreement and then select I accept the
agreement and then click Next or ‘Cancel’ if you do not accept
the agreement. Clicking ‘Cancel’ will stop the software
installation.

Follow the prompts, selecting Yes, Next or OK on each page.

The SpectrAA User Information window will be displayed.
Check that the selections are correct, or reenter them, and then
click Next.

Follow the prompts, selecting Yes, Next or OK on each page.
Click Install.

From the ‘SpectrAA Instrument Configuration’ window, select
your instrument type from the drop down list on the
‘Instrument #1’ page. Then do the following:

If you are running a one instrument system:

Continue with Step 11.

Agilent 240/280 Series AA User’'s Guide



Installation

If you are running an Agilent AA-DUO system (simultaneous
flame and furnace operation):
You must now set up the second instrument. To do this:

Select the DUO check box.
b Select the Instrument #2 tab.

¢ Select the instrument type from the drop-down list. It does
not matter which instrument is assigned to which page,
however, ‘Instrument #1’ must have the IEEE “9” setting and
‘Instrument #2’ must have the IEEE “8” setting. The IEEE
settings are configured after installing SpectrAA PRO. Take
note of which instrument is listed in ‘Instrument #2’. See the
following image.

-
@ SpectrAA Instrument Configuration M

Please select model and configuration for your Instrument.
*rou may optionally set up a second instrument,

Settings are saved ta the following fil:
C \FrogramData\dgilentisp] I0VSFECTRAL INI I

Instrument $

Modek
Agilert 2807 A4 |
Gashox type:
i
None -
L
Lamp systern i
& lamp turret = L
[
i
Note: (i Spectib, PR softwsre can rn teo I
instuments. If two Instruments are connected, then
one must be Flame type and the other must be
Fumace
oK Cancel |

11 If you are using any accessories, click the Accessories tab in the
‘SpectrAA Instrument Configuration’ window. Select your GTA
(Graphite Tube Atomizer), Flame Autosampler and /or ETC 60
from the drop-down lists.

a Ifyou select GTA 120, the option for High capacity racks is
enabled. Select this option to enable support for the optional
high capacity carousel (130 x 1.1 mL samples and 5 x 10 mL
standard/modifier solutions).
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12
13
14

15
16

17
18
19

b If you select Agilent SPS 3 flame autosampler, click Edit
COM port parameters to define the COM port and the
settings to be used for communicating with the autosampler.
Refer to the SPS 3 operation manual for details of the
required communications parameters.

¢ Ifyou are installing the ETC 60 and want to control this
accessory from the SpectrAA software, select the COM Port
from the drop-down menu to be used to control this
accessory.

Click OK.
Once the installation is complete, click Finish.

A message may appear prompting you to install the QuickCam
drivers. Click OK to dismiss the message. You must install the
SpectrAA PRO and/or the GPIB Communications device first.

The QuickCam drivers are installed later in this procedure.

Click OK to install the SpectrAA Help.

Remove the SpectrAA Base CD and then insert the SpectrAA
Help CD. The installation program should start automatically. If
the program does not auto start, do the following:

a From the Windows Start menu, select All Programs >
Accessories > Run. The Run dialog displays.

b In the Run dialog, type X:\AAHelp\setup.exe (where X
represents the letter of your CD-ROM drive) and select OK to
start the installation.

¢ Click Yes on the User Account Control window to run the
program.

Click Yes to start the SpectrAA Help and Videos installation.
Click Finish when the installation is complete.

Do one of the following:

If you are installing SpectrAA PRO, proceed to the next section
‘Installing the SpectrAA PRO Software’, or

Reboot your PC and then install the PCI-GPIB Communications
Card (see Page 51) or the USB-GPIB-HS Converter (see Page 55).
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Installing the SpectrAA PRO Software

Installation of the SpectrAA Base version 5.2 or greater must be completed prior
to installing the SpectrAA PRO version 5.2 or greater software. Refer to Page 42
for details.

The selections entered during installation of the Base software (such as User
Information, Directory Location) will be used for the PRO installation.

To install the SpectrAA PRO software:
1 Close down all Microsoft Windows applications.

2 Insert the SpectrAA PRO CD-ROM into your CD-ROM drive. The
installation program should start automatically. If the program
does not auto start, do the following:

a From the Windows Start menu, select All Programs >
Accessories > Run. The Run dialog displays.

b In the Run dialog, type X:\SpectrAAPro.exe (where X
represents the letter of your CD-ROM drive) and select OK to
start the installation.

¢ Click Yes on the User Account Control window to run the
program.

3 Select the language from the drop-down menu to use during the
installation of the SpectrAA software. Click OK.

Select Next to start the installation.

Review the License Agreement and then select I accept the
agreement and then click Next or ‘Cancel’ if you do not accept
the agreement. Clicking ‘Cancel’ will stop the software
installation.

Follow the prompts, selecting Yes, Next or OK on each page.

7 A dialog box appears asking for confirmation of the installation
destination for SpectrAA Pro.exe. Click Yes to install into the
previously created SP100\Run folder

8 Click Install to begin the installation.
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The SpectrAA Instrument Configuration window will be
displayed again. Check that the selections are correct and click
OK. Take note of which instrument is listed in ‘Instrument #2’ if
running an Agilent AA-DUO system.

-
@ SpectrAA Instrument Configuration M

Please select model and configuration for your Instrument.
*rou may optionally set up a second instrument,

Settings are saved to the follawing file:
C:\ProgramD atabhgilent'ep] OOV PECTRAL M1 I

Modet
Agilent 2807 Ak

Gashox ype:

None - I

Lamp system

& lamp turrst -

Note: Only Spectrdd, PRO software can run two
instuments. If two Instruments are connected, then
one must be Flame type and the other must be
Fumace

[ x| Cancel ‘
During installation, you will be asked whether or not to delete
the files ‘Workgrp.ini’ and ‘User.ini’. These are created if you
opened the SpectrAA software after installing SpectrAA Base but
before installing SpectrAA PRO. Select ‘Delete this file’
(recommended) for both dialog boxes.

Click ‘Yes’ to install the SpectrAA Help if you skipped that step
during the SpectrAA Base installation or ‘No’ to cancel the Help
installation if it has already been completed.

Once the software installation is complete, restart your
computer.
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Installing the SpectrAA CFR Software

This procedure is only for use with Windows XP SP3 systems and SpectrAA CFR
version 5.1 (27) software. If you are not using SpectrAA CFR software
version 5.1 (27), please see Page 42 for software installation instructions.

Because the CFR version is an upgrade to the base installation, the
SpectrAA Base version 5.1 (27) must be installed before any
installation of the CFR version. The operating system must be
installed before starting the SpectrAA software installation.

Installing the SpectrAA Base Software

Windows XP (SP3), with NTFS file system is required for the SpectrAA CFR
version. Currently, SpectrAA CFR is not compatible with Windows 7.

To install the SpectrAA Base version 5.1 (27) software:

1 Ensure that the PC is on and that no other Windows applications
are running,.

2 Insert the SpectrAA CD into the CD ROM drive. The installation
program should start automatically. If the program does not auto
start, do the following:

a From the Windows Start menu, select Run. The Run dialog
displays.
b In the Run dialog, type X:\SETUP.EXE (where X represents

the letter of your CD-ROM drive) and select OK to start the
installation.

3  Once the installation program commences, follow the prompts,
selecting Yes, Next or OK on each page.

4 On the User Information window enter the user information as
requested.
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From the ‘Choose Destination Location’ window, select the drive
or sub-directory where the SpectrAA software will be installed. If
you wish to install the file in a directory other than the default
location, select Browse.

From the Select Program Folder window choose the name the
program shortcut will use on the Windows Start menu.

On the Start Copying Files window, check that all settings are
correct. Select Next to begin the installation.

From the ‘SpectrAA Instrument Configuration’ window, select
your instrument type from the drop down list on the
‘Instrument #1’ page. Then do the following:

If you are running a one instrument system:
Continue with Step 9.

If you are running an Agilent AA-DUO system (simultaneous
flame and furnace operation):
You must now set up the second instrument. To do this:

Select the DUO check box.
b Select the Instrument #2 tab.

¢ Select the instrument type from the drop-down list. It does
not matter which instrument is assigned to which page,
however, ‘Instrument #1’ must have the IEEE “9” setting and
‘Instrument #2’ must have the IEEE “8” setting. The IEEE
settings are configured after installing SpectrAA CFR. Take
note of which instrument is listed in ‘Instrument #2’. See the
following image.
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@ SpectrAA Instrument Configuration M

Please select model and configuration for your Instrument.
*rou may optionally set up a second instrument,
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9 If you are using any accessories, click the Accessories tab in the
‘SpectrAA Instrument Configuration’ window. Select your GTA
(Graphite Tube Atomizer), Flame Autosampler and /or ETC 60
from the drop-down lists.

a Ifyou select GTA 120, the option for High capacity racks is
enabled. Select this option to enable support for the optional
high capacity carousel (130 x 1.1 mL samples and 5 x 10 mL
standard/modifier solutions).

b If you select Agilent SPS 3 flame autosampler, click Edit
COM port parameters to define the COM port and the
settings to be used for communicating with the autosampler.
Refer to the SPS 3 operation manual for details of the
required communications parameters.

¢ Ifyou are installing the ETC 60 and want to control this
accessory from the SpectrAA software, click Edit COM port
parameters to define the COM port to be used to control this
accessory.

d Click OK.

10 From the AA Language Installer window, select your preferred
language from the drop down menu. SpectrAA uses the selected
language where possible. Where the selected language is not
available (as is the case for some of the cookbooks), English is
displayed. Select Install to continue the installation.

Agilent 240/280 Series AA User's Guide 49



Installation

1"

12

13

When requested, remove the installation CD and replace it in the
CD drive with the SpectrAA Help and Videos CD ROM. Click OK
to install the Help.

From the ‘Install Videos’ window, you can select to copy the Help
videos to your hard disk (recommended). This will enable you to
view the videos at any time without inserting the Help and
Videos CD-ROM into the CD drive. Select the destination folder
for the videos (if applicable) and click Yes or No as required.

Once you have finished installing the base software, click Finish
to complete the SpectrAA Base installation. Follow the
instructions in the next section to install the SpectrAA CFR
software.

Installing the SpectrAA CFR Software

Windows XP (SP3), with NTFS file system is required for the SpectrAA CFR
version. Currently, SpectrAA CFR is not compatible with Windows 7.

Installation of the SpectrAA Base version 5.1 (27) must be completed prior to
installing the SpectrAA CFR software. Refer to Page 47 for details.

The selections entered during installation of the Base software (e.g. User
Information, Directory Location) will be used for the CFR installation.

50

To install the SpectrAA CFR software:

1
2

Close down all Microsoft Windows applications.

Insert the SpectrAA CFR CD-ROM into your CD-ROM drive. The
installation program should start automatically. If the program
does not auto start, do the following:

a From the Windows Start menu, select Run. The Run dialog
displays.

b In the Run dialog, type X:\SETUP.EXE (where X represents
the letter of your CD-ROM drive) and select OK to start the
installation.
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3 Once the installation program commences, follow the prompts,
selecting Yes, Next or OK on each page.

4 The SpectrAA Instrument Configuration window will be
displayed again. Check that the selections are correct and click
OK.

Once the installation is complete, restart your computer.

Shutdown the PC and install the National Instrument PCI card.
Refer to Page 51 for details.

7 Once the PCI card is installed, if you are running an Agilent AA-
DUO system, you will now need to configure the Agilent AA-DUO
system. Refer to Page 55 for more details.

Shut down the PC, re-start it and open the SpectrAA. As soon as
the Index page is displayed, shut down the PC again. This
automatically creates the necessary configuration files.

GPIB Communications

Either a GPIB communications card or the optional USB-GPIB-HS
converter must be installed in your computer to interface the
computer and the Agilent AA. See the next section for information on
installing the PCI-GPIB communications card or Page 55 for
connecting the USB-GPIB-HS converter.

Although the Agilent field service engineer will install the GPIB communications
device for you during the installation process, you may need to configure the
driver yourself at some later stage, for example if you change the PC.

Installing the PCI-GPIB Communications Card

The National Instruments PCI-GPIB card supplied with the
instrument must be installed in your PC to interface the PC with the
Agilent AA spectrometer and accessories.
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The components on the communications card and in the PC are highly static-
sensitive. To avoid damaging these components you must drain any static
charges from your body before installing the board, and prevent the generation of
any new static charges during the installation.

This can be done by wearing an ESD (electrostatic discharge) wrist strap
attached to a grounding point. You can obtain a disposable ESD strap from
Agilent, otherwise you can obtain one from your local electronics supplier.

To install a National Instruments PCI-GPIB communications card:

Ensure that the SpectrAA software has been installed.

1 Turn off and unplug the computer.

2 Remove the cover, following the instructions in the manual
provided with the computer.

3 Attach one end of the ESD strap to a bare metal part of the PC
chassis and wrap the other end around your wrist.
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4 Remove a blanking plate from one of the empty slots in the
computer.

b Remove the card from its static-shielded packaging. Do not touch
the gold edge connectors.

6 Press the card firmly into the empty PC slot. The gold edge
connectors should slide firmly into the matching sockets of the
PC slot. Secure the card with the screw.
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8 Connect the cable between the instrument and the computer (one
end plugs into the interface board in the computer, and the other
plugs into the socket in the rear of the instrument).

9 Connect the computer to the mains power.

10 Turn the computer on.

Configuring the PCI-GPIB Communications Card

Microsoft Windows XP and Windows 7 use ‘plug-n-play’ for fully
automatic setup.
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Installing the USB-GPIB-HS Converter
To install a National Instruments USB-GPIB-HS converter:

Ensure that the SpectrAA software has been installed.

1 Turn off the computer.

2 Connect one end of the converter to the instrument and the other
end to the USB connection on the back of the computer.

3 Turn on the computer.

Setting Up for Agilent AA-DUO Operation

You must install the GPIB Communications Card or Converter first before
performing this procedure.

If you are running an Agilent AA-DUO system, you need to
reconfigure one of the instruments so they have different IEEE
addresses.

To reconfigure an AA for use in an AA-Duo system:

1 Ensure the SpectrAA Base and PRO or CFR software is installed.

2  With the computer turned off, connect the two Agilent AA
instruments via an IEEE-488 GPIB cable.

3 Connect one of the Agilent AA systems via an IEEE-488 GPIB
cable to the GPIB card in the computer or by connecting the USB-
GPIB-HS converter to the computer.

Reboot the computer if you haven’t done so already.
Ensure that both instruments are switched off.

From the Windows 7 Start menu, select All Programs >
Accessories > Run or from the Windows XP Start menu, select
Run. The Run dialog displays.
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In the Run dialog, for Windows 7 type C:\Program Files
(x86)\Agilent\sp100\Run\DUAL.EXE or for Windows XP type
C:\SP100\RUN\DUAL.EXE and then select OK to start the
program.

A window displays asking you to turn on the instrument you
wish to reconfigure. You must select ‘Instrument 2’ in the
configuration. When you have switched on the instrument, select
OK.

A command window is displayed. The process may take about a
minute. During this time you will hear the instrument resetting.

Restart the computer and open the SpectrAA. As soon as the
Index page is displayed, shut down the PC again. This
automatically creates the necessary configuration files.

Restart the computer, turn on both AA instruments and then
start the Agilent SpectrAA software.

The instruments are now ready to be used as a simultaneous
flame/furnace system. Refer to the Help for further information on
dual instrument operation.

During dual instrument operation do not turn any connected instrument ON or
OFF while readings are being taken.

Starting the SpectrAA Software

To start the SpectrAA software:

1

Click Start > (All) Programs > SpectrAA and then SpectrAA
again. Alternatively, double-click the SpectrAA icon on the
desktop.

The first time the SpectrAA software is opened a Software
Registration dialog will appear. Click Next.

Ensure the software registration is completed by the user of the SpectrAA
software. For further information refer to the Software Registration Help.

56

3

Complete all the fields on the ‘Customer Details’ page. Click
Next.
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The Product Key is found on the cover of the Agilent SpectrAA software CD
case which was delivered with the instrument.

Complete all the fields on the ‘Product Details’ page. Click Next.
Complete all the fields on the ‘Work Environment Details’ page.
Click Register.

~N oo e A

A dialog appears stating ‘Your Agilent Software Registration has
been successful’.

If your computer is not connected to the internet, refer to the Software
Registration Help for further information.

8 The application will now open, and you can collect your data.

SpectrAA Release Notes and Software Status Bulletin

Refer to the SpectrAAReleaseNotes.pdf file in the installation
directory and the Software Status Bulletin document for further
details. The file includes latest release information and important
notes including the detail of any know problems and suggested work-
arounds.

Installing the Drivers for the Tube-CAM Furnace Camera Option

These instructions are required only if the Tube-CAM furnace video option has
been fitted to your instrument.

It is only necessary to install the driver files as described in the
following procedure. While it is possible to install all options, these
are not necessary for operation of the camera in SpectrAA software.

This installation refers to Logitech PRO9000 cameras.
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Driver Installation

To install the drivers:

1

Ensure the SpectrAA software has been installed and the
computer has been restarted. Do not open the SpectrAA software
and do not connect the camera.

Insert the Logitech Quickcam CD-ROM into your CD-ROM drive.
Navigate to the installation CD and double-click ‘Setup.exe’.

Select your preferred language in the ‘Preferred Language’ dialog
box on the ‘Welcome’ screen and then click Next.

Ensuring that the camera is not connected, (contrary to screen
instructions) click Next.

Select Custom Install and then click Next on the ‘Choose Set-up’
screen.

On the ‘Install Webcam Software’ screen (see Figure 2):
a Select ‘Logitech Webcam Software’.
b Deselect ‘Logitech Motion Detection’.

Deselect ‘Logitech Video Effects’.

Deselect ‘Logitech Vid-HD’.

c
d Select ‘Logitech Webcam Drivers’.
e
f Click Next.
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=3 Logitech Webcam Software Installation

) Install Webcam Software
Logitech Webcam

Software Installation z.o Go ahead and choose what you want te install and
where.

Description
B~ [¥] Logitach Webcam Software nstal drivers o enable

=0 Logitech Motion Detection all your webcam's
L [[] Logtech Video Effects festees
2. Choose setup | ©

B [0 Logitech Vid HD

Welcome

3 . Install my software

4 . Finish Instal
Total Size:154 MB
Installation Directory
C:\Program Files\Logitech -
’
€
~
Logitech

Figure 2. Logitech Webcam Drivers installation window

8 If an ‘Update’ screen is displayed, click Next.
The ‘Installing Software’ screen will be displayed.

9 After the installation has completed the ‘Check Settings’ screen
will be displayed. Click Next.

10 The software is now installed. Click Checkout my webcam.
The Logitech Webcam Software will be displayed.

11 Plug in the Logitech Webcam into the USB port on the
spectrometer.

If installation is successful an image of a Logitech Webcam
camera will be displayed on the software window.

12 Select Quick capture and then Controls.

The image from the Tube-CAM video is not currently displayed in
the ‘Webcam Control’ window because the hollow cathode lamps
are not yet illuminated.
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13 On the ‘Controls’ screen:
a Deselect ‘RightSound’
b Deselect ‘RightLight’.
¢ Deselect ‘Autofocus’.
d Select ‘Advanced Settings’.
14 When ‘Advanced Settings’ are displayed:
a Deselect ‘Auto’ to the right of the ‘Gain’ slider.
b Set the ‘Exposure’ and ‘Gain’ sliders to maximum.
¢ Click Save.

The camera image will appear black because the SpectrAA is turned
off.

Printer Setup

The printer must be a make and model supported by Windows. To
install your printer, follow the instructions provided with the printer.
For more information refer to your printer documentation or
Microsoft Windows Help.

Troubleshooting

60

This section contains solutions to some common problems you may
encounter during the installation of the SpectrAA software.

The SpectrAA software isn’t communicating with the instrument.

e Ensure the computer has been restarted after installing the
software and the GPIB card or USB-GPIB-HS converter.

¢ Check the cables and connections.

e Check that the instrument and any associated accessories are
turned on.

¢ Check that you are not running the Simulator software. (Select
Help about system information.)

¢ Ensure the PCI-GPIB driver has been installed and configured.
Refer to Pages 51 and 54 for details.
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The Agilent AA system software (SpectrAA) is a powerful interface
that provides high levels of spectrometer control and is easy to use.
This chapter provides a brief overview of the SpectrAA software to
help you familiarize yourself with its various windows. A more
detailed description and instructions for use are included in the
extensive Help. The optional SpectrAA CFR version software offers
you the tools to help you achieve compliance with the US FDA 21
CFR Part 11 requirements. More information on the CFR compliance
features of the software is detailed in the Help.
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Starting the SpectrAA Software

To start the SpectrAA software click Start > Programs > SpectrAA.
Alternatively, double-click on the desktop SpectrAA icon (created
during the installation of the software).

SpectrAA Windows

Index Page

When you start the SpectrAA software, the first screen to appear is
the introductory screen.

The Index page contains four buttons: Worksheet, Reports,
Administration and Exit.

The function of each button is as follows:

Worksheet Opens the Worksheet window (see Page 63)
Reports Opens the Reports window (see Page 65)
Administration Opens the Administration window (see Page 66)
Exit Shuts down the SpectrAA software.
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Worksheet Window

The Worksheet window allows you to develop and edit methods,
sequences and labels, and initiate sample analysis.

L =lelx
Edt bew nenment opons Wrdonbep
@ @0 g |wex = [BO0EOE 2% S
Fig | Dewks | Labek Aoz |
"

2P Meansbs

Senghs 005

jale

am

T = i
As e Corcerbaton Ak Homel
FRONT 1001 10%  N20smempme

RowSa5
BCon Renkrame 0

) T
Figure 3. The Analysis page of the Worksheet window

The worksheet is the fundamental file type for SpectrAA, containing
one or more methods, sample labels, sequence information and

analytical results. You may load an existing worksheet or develop a
new one.

The Worksheet window consists of four tabbed pages: Filing,
Develop, Labels and Analysis. To access a particular page, click on
the appropriate page tab appearing under the menu bar.

The Filing Page

Use the Filing page to perform basic worksheet operations such as
opening, saving, and closing worksheets, creating a template from a
worksheet and loading worksheets. You can also view information
about the worksheet currently open. If you have the CFR version of
the software, the Filing page enables you to apply electronic
signatures (approval) to the worksheet.
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The Develop Page

Use the Develop page to add, delete, review and modify methods,
modify sequence parameters, change the order of methods and copy
methods to the Method Library.

The Labels Page

Use the Labels page to set up solution labels, weights, volumes and
dilution factors and to configure SPS or PSD samplers.

The Analysis Page

Use the Analysis page to control the AA and initiate analysis. Data is
presented in the form of a spreadsheet, with one row per sample. The
sample labels are displayed in the left hand column with
concentration results for each element across the remaining columns
(see Figure 3).

The SpectrAA software enables you to have up to a maximum of ten
worksheets open at the same time. The Worksheet tab at the bottom
of the Analysis page enables you to switch between worksheets.

Worksheet Menus

When you are viewing the worksheet the following menu items are
available:
File This menu allows you to perform filing tasks such as opening, saving
and renaming files.
Edit The Edit menu allows you to copy and paste information, Edit
Replicates and Go To certain parts of a worksheet.
View The View menu enables you to nominate what is displayed on the
Analysis page.
Instrument  This menu enables you to perform many Instrument functions such as
Optimization, Reslope and Zero.

Options The Options menu enables you to alter the displays on the Analysis
page.

Window This menu enables you to quickly move around the software.

Help This menu enables you to access the Help.
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Not all menu items are available on all pages of the Worksheet window. If an
item or menu is grayed it is unavailable on that page.

Menu items can be accessed by clicking on the desired item with the
mouse, or pressing Alt and the active (underlined) letter in the menu
name (e.g. Alt+E to access the “Edit” menu). This displays a menu
list. The options in the menu list can be accessed in the same

manner.

Reports Window

The Reports window allows you to generate a report for the current
worksheet or any of the worksheets saved in the system.

4 peports - dd ) x|
workshest I Select Report |
Select the Report Style and Contents. These settings can be saved permanently if required.
[Beport Sle —————————— Note. Because of the tandam access
e nature of the wolkshes!, calibration
information is only available for
I Drder by Time Sequential, Time Didered reparts
 Muli Element
[~ Solution Data Repart Contents
¥ Mean sbsarbance I” Date IV Standards
I¥ Concentration " Time I” Method Parameters
¥ %RSD ™ Ovenangs Dilution Factor ™ Method Notes
I Standard Deviation I™ weights and Yolumes ¥ Sequence Notes
¥ Replicates I IS Factars ™ Dilution Factors
V¥ Mean Background [ Calibration Parameters
~EmorRepottvg—————————————— Signal Graphics Lalibration Graphs ———
I~ Enoi Messages I~ Standards [~ Report
I O Flags I~ Samples
< Back Hext > Save Settings

Lloge Help

Figure 4. The Settings page of the Reports window

The Reports window consists of four tabbed pages: Worksheet,
Select, Settings and Report. To select a particular page, click on the
appropriate page tab appearing under the menu bar.
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The Worksheet Page

Use the Worksheet page to select the worksheet results to include in
the report. You can use the “Filter” and “Search” buttons to refine
your search.

The Select Page

Use the Select page to choose methods and solutions to include in the
report.

The Settings Page

Use the Settings page to specify the report style and content.

The Report Page

Use the Report page to view and print the report, write it to a text
file, or export it to a PRN file.

Administration Window

The Administration window allows you to: migrate worksheets into
the system (such as old worksheets on CD-ROM, etc.); delete
worksheets and library methods; and activate and modify password
protection of the system. The Administration window also allows you
to configure your system.

“& pdministration - Password Protection: DFF x|
— worksheet Migration — Security Options — Configuration
; ™ Password Protection S pectid,
Miarate
ol Paszsword
w Settingz... QCP Mames

 Delete
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Usage Counters
sy Library M Customize
‘H Methods... Backs...
Cloze Help

Figure 5. The Administration window

66

Agilent 240/280 Series AA User’'s Guide




Software Overview

Working With the SpectrAA Software

Menu Bar

The Worksheet window contains a menu bar directly beneath the
window title bar. This bar displays a number of menu items. For
more information on these menus see Page 64.

When menu items or options appear grayed they are unavailable for selection.

Toolbar

The Toolbar appears on the Index page and the Worksheet window
and provides easy shortcuts to many common functions and other

windows.
EEHE A e 3 |HHDE 28 | |gRaeS

Figure 6. The Worksheet window toolbar

Dialog Boxes

In some cases, selecting a menu option or pressing a button activates
a dialog box. This is a box that contains a number of different input
fields relevant to that operation.

You can move the focus from field to field in a dialog box either by
clicking on each entry item with the mouse or by pressing the Tab
and arrow keys to move the cursor from field to field. After
entering/changing any values in a dialog box, press “OK” to accept
the changes and close the dialog.

Help

The SpectrAA software contains extensive Help, which serves as your
primary source of information on how to effectively use the software
and the instrument. The Help consists of contextual help and
multimedia help. The Help also contains an extensive ‘How To...’
section. This section provides many set by set instructions on how to
perform common procedures.
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The contextual help is accessed from any window, page or dialog box
in the SpectrAA software by pressing F1 (the Help function key), the
‘Help’ button (where available), or by selecting ‘On-line Help’ from
the Help menu at the top of any page in the Worksheet window, and
provides help specific to that screen.

The multimedia help contains hardware-related information and
other details to help you set up, operate and maintain your Agilent
AA instrument.

For example, the Help includes:

e Installation procedures for the components of the instrument
that are customer-installable

¢ Maintenance procedures for the parts of the spectrometer that
are customer-serviceable

¢ Checklists to help you ensure that you have correctly prepared
your system for analysis.

To view the video clips included in the online help you must have the SpectrAA
CD inserted in the CD-ROM drive. Alternatively, you can copy the video files from
the Help CD into the \\run\help subdirectory within the directory where the
SpectrAA software is loaded.
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Searching for Help

You can quickly get Help on a specific topic using keywords and the
Search facility.

To search for information on a particular subject:
1 Open the Help (if it is not already open).
2 Select the Search tab at the top of the SpectrAA Help window.

3 Enter the word(s) you want to search for in the field provided
and select List Topics.

4 A list of all the Help topics associated with the keyword(s)
displays in the second list.

b5 Select the desired topic and click Display.
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Printing Help
To obtain a printed copy of the current Help topic:

1 Select the Print icon at the top of the SpectrAA Help window.

2 From the Print Topics dialog, select whether you want to print
the selected topic or a range of topics and then select OK.

The topics you selected will be printed on the nominated printer.

Information presented in a popup window cannot be printed.

Viewing Help While You Work

If the Help window obscures the application you are working in, you
may want to resize the Help window or move it so that you can view
both the Help window and your application window at the same
time. This is useful if you are using Help to follow a step-by-step
software procedure.

Quitting Help

To close the SpectrAA Help window, select the “X” on the top right
corner of the Help window or press Alt+F4 to close the window.
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This chapter describes how to set up the Agilent AA system for
analysis and get you started using the instrument.

You should have already:

e Prepared your PC and installed the SpectrAA software as
described in Chapter 3.

¢ Become familiar with the SpectrAA user interface as described in
Chapter 4.

Instrument Setup

Use the following checklist to ensure that you set up your system
correctly. You must:

¢ Connect the components of the system to one another (see
‘Connections’ on Page 72).

¢ Connect the equipment to the power supply, and check the
setting of the two voltage taps where fitted (see ‘Power’ on Page
72).

e Install the hardware components as per your analytical
requirements. Refer to the Help for details.
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Connections

Your Agilent AA instrument is supplied with a set of gas hose fittings
and a mains cable which suits the common utility standard in the
local region. A Country Kit must be ordered with the Agilent AA
instrument.

Power

The mains power connection is located at the rear of the instrument.
Refer to the next section for instructions on connecting the
instrument to the mains power supply.

Gas Hoses

Three rubber hoses are permanently attached to the instrument.
Each hose is 1.8 meters long and is color-coded for air (black),
nitrous oxide (blue) and acetylene (red). Each is fitted with female
fittings suitable for USA standard regulators. Adaptors are supplied
for other areas.

Gas hose connections are not detailed in this section as they are described in
your Agilent AA Site Preparation Guide.
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Accessories

For details on connecting accessories such as SIPS or UltrAA lamps,
refer to the manuals accompanying the accessories.

Power

Requirements

Power requirements are detailed in your Agilent AA Site Preparation
Guide, and also in the Specifications section in Chapter 1 of this
manual. You should check the power requirements and read through
the section ‘Electrical power supplies’ in the Site Preparation Guide
before connecting the Agilent AA system to the power supply.

Consult the manuals supplied with your printer and PC (if required)
for their power requirements.
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Connection

Before connecting the instrument to the power supply, ensure that
both the spectrometer and the mains power supply are turned off.
Check that the two voltage selector switches on the instrument rear
panel (if present) are set to the correct mains power supply voltage—
refer to the table on the rear panel. The voltage selectors are set by
the Agilent field service engineer when the instrument is first
installed.

To connect the instrument to the power supply, plug the mains
power cord into the back of the instrument and the free end of the
power cord into the mains power supply, and then switch the mains
power supply on.

Moving Your Instrument

m Heavy Weight

The instrument weighs over 50 kg (110 Ib). Do not attempt to lift the

instrument alone. Always use two or more people when lifting or carrying the
instrument into position.

Starting the System

The instrument power switch is a rocker type, located on the front of
the instrument on the left hand side. Switch this to ‘I’ to start the
system. The green indicator light should come on.

For instructions on how to start any accessories, refer to the manuals
supplied with the accessories.

If you have not already done so, start the SpectrAA software as
described on Page 62.
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Pre-analysis Checklist

The general preparation procedure is as follows:

1

Install all the required hardware, including any associated
accessories such as SIPS, according to the instructions in the
Help (see Page 67) and any accessory manuals.

Turn on the instrument and any peripheral accessories as
described in the previous section.

Ensure the exhaust system is working. To do this, hold a thin
single-ply tissue up to the mouth of the extraction hood. The
tissue should be drawn towards the hood.

Check the gas supplies to make sure you have enough gas to
complete your analysis. You must also check that the acetylene
cylinder pressure is above 700 kPa (about 100 psi) to ensure that
acetone is not drawn into the instrument.

Set the delivery pressure of the gases to the following:

Recommended Permissible
kPa psi kPa psi
Acetylene 75 1" 65-100 9.5-145
Air 350 50 245-455 35-65
Nitrous oxide 350 50 245-455 35-65

Inspect the gas hoses for damage, replacing any damaged hoses.
Turn on the gas supplies to your instrument and test all hoses
and connections for leaks. If a leak is found, repair it
immediately.

Load a worksheet and develop the method(s) as per your
analytical requirements.

Optimize the system.

Start an Autorun.

Detailed procedural help for Steps 7 to 9 are provided in the Help. See Page 67
for details of how to find information in the Help.
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